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Introduction 

This manual contains guidelines for creating component group “microsites” in SAA’s Web content 

management system, Drupal. In addition to being a resource for volunteer member leaders, the 

purpose of this document is to foster coordination between committees, sections, roundtables, and 

the SAA staff in order to develop a highly informative and easy-to-use website for the entire Society. 

SAA’s overall Web presence is comprised of a number of different systems. Identifying these systems 

and their functions is helpful in understanding how your site fits into to this larger framework: 

 The “SAA Intranet” (http://saa.archivists.org) contains select information that is dynamically 

published from SAA’s member database or association management system (AMS); 

 The “SAA Extranet” is the Society’s proverbial front door on the Web and contains content 

that cannot be managed effectively via the AMS: 

o SAA’s old Extranet site resides at http://www.archivists.org. 

o Drupal (the new Extranet site) resides at http://www2.archivists.org. 

o Staff and component groups alike are still in the process to migrating content from 

the former to the latter. 

 A variety of other systems add specific functionality not currently supported by either the 

Intranet or the Extranet. These include SAA’s list server (http://forums.archivists.org), 

American Archivist Online (http://archivists.metapress.com), the Online Career Center 

(http://careers.archivists.org), and social networks such as Facebook, LinkedIn, and Twitter. 

Every group listed in SAA’s Leadership Directory (http://www.archivists.org/leaders/) has a basic 

page on the SAA Intranet, which contains: 

 The group’s official charge, if applicable; 

 A basic description of the group; and 

 Links to: 

o The group’s leader and/or member roster(s); 

o The group’s official email discussion list; 

o The group’s microsite in Drupal, if applicable; 

o Reference documents on SAA policies, procedures, and guidelines. 

Auxiliary Group Websites 
Sustaining interoperability and usability within and between the variety of systems outlined above 

can be a challenge—one that these guidelines seek to address. Due in part to this complexity, SAA 

boards, committees, subcommittees, sections, roundtables, working groups, and task forces may 

not create auxiliary sites, including websites, e-mail discussion lists, wikis, blogs, document sharing 

sites, and social networks, without prior approval from the Executive Director.  

Please email SAA Headquarters at saahq@archivists.org for additional information. 

http://saa.archivists.org/
http://www.archivists.org/
http://www2.archivists.org/
http://forums.archivists.org/
http://archivists.metapress.com/
http://careers.archivists.org/
http://www.archivists.org/leaders/
mailto:saahq@archivists.org
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Drupal Basics 

Assignment of Editing Privileges for Group Leaders 
Group microsites may be managed by active leaders who are designated in the official group rosters 

maintained by SAA staff. Assignment of a leader role in the member database automatically confers 

privileges in Drupal. Three permission levels have been configured: 1) Group Officers; 2) Group 

Editors; and 3) Group Contributors. These terms do not necessarily correspond to named roles on 

your steering committee. For example, a “group officer” in Drupal could be a first-year steering 

committee member with particular interest and/or aptitude in Web content management. The 

Group Editor role is assigned by default. Staff will manually change group leaders to the Group 

Officer or Group Contributor roles upon the request of the Chair(s). Group Officers have full 

permissions to manage the group site. Group Contributors have only limited permissions. 

For more information on group leader assignments, resources, and responsibilities, please see the 

SAA Leader Manual available online at http://www.archivists.org/governance.  

Introduction to “Nodes” and “Content Types” 
Every discrete piece of content administered in Drupal is a node. The term “node” is simply an 

abstraction used to refer to any record, regardless of type. Content types are configurations that 

facilitate the effective management of different formalized record types. The constituent data 

structures and relationships within and between these content types can be simple or complex.  

Component group content types and their related permissions are displayed in the Table below. 

These types are configured globally, even though they may not apply to the circumstances and needs 

of all groups. (For example, committees generally do not publish “newsletters.”) 

Table of Component Group Content Types and Associated Permissions 

Key: S = Staff Editor     O = Group Officer     E = Group Editor     C = Group Contributor     

Notes: Higher roles inherit privileges assigned to lower roles. Staff Editors have full permissions. 

 Permissions are subject to change. 

 Create Edit Publish Unpublish Delete Add to Feed? 

Group Homepage S O S S S n/a 

Group Menu O O O O S n/a 

Group News Item C C C C O Yes 

Group Page E E E E O No 

Group Newsletter E E E E O Yes 

Group Report O O O O S Yes 

Group Meeting O O O O S Yes 

Meeting Agenda O O O O S No 

Agenda Item E E O O S No 

Meeting Minutes O O O O S No 

Standard S O S S S No 

http://www.archivists.org/governance
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Getting Started 

Once your Group Homepage is created by the SAA staff and leader roles are assigned in the AMS, 

you’re ready to start configuring your microsite for use. If you’ve never accessed your site before and 

a public link is not yet active in the general navigation menu, locate your microsite as follows: 

1. Log into to Drupal via your personal SAA Profile; 

2. Click “My Account” in the top right corner of the screen; 

3. Click on the appropriate link under your list of groups. 

If you do not see a link, you may need to have your leader role activated by SAA staff. In addition, 

Group Officers and/or Web Liaisons should work with staff to coordinate public links to your site 

once it is ready for use. Email Brian Doyle at bdoyle@archivists.org for additional assistance. 

Your Group Homepage 

Your microsite homepage is created by staff and corresponds to a record in SAA’s member database.  

The homepage consists of: 1) the group name; 2) introductory/welcome text; 3) a “Recent News  

& Announcements” feed that displays selected content in reverse chronological order; 4) an 

“Automatic Display of Group Nodes” feed that lists of your microsite nodes by content type in 

reverse chronological order; 5) an administrator menu; and 6) custom menus. (See Figure 1.) 

 
Figure 1. Example of a component group homepage, as viewed by the Group Officer. Display of 
“View” and “Edit” tabs and administrator menu items is contingent upon user permissions. 

mailto:bdoyle@archivists.org


Society of American Archivists | 2011 Drupal Manual 
 

6 

Editing the Group Homepage 

Group Officers may edit introductory/welcome text published on the homepage and access other 

administrative settings associated with the entire microsite by clicking on the “Edit” tab at the top of 

the Group Homepage. 

Theme: Use of the “SAA Theme” is strongly recommended. 

Description: You may leave this field as is. 

Full Group Description: The contents of this field correspond to your introductory/welcome 

message. Enter content to greet your visitors. It is recommended that you be succinct 

because extensive text may push the Recent News & Announcements Feed “below the fold.” 

Hide Automatic Display of Group Nodes: See below. 

Header/Footer: The header and footer fields are intended for creating custom page 

templates using the “Blank Theme” option. It is recommended that these fields be left blank. 

Comment Settings: Disabled by default (recommended). 

File Attachments: Generally, files are attached to other microsite nodes. However, they are 

also supported on the Group Homepage if desired. 

Hide Automatic Display of Group Nodes (“Auto-links”) 

Links to group content appear at the bottom of all nodes in your microsite. They are arranged in 

reverse chronological order by content type and cannot be rearranged. To give Group Officers more 

flexibility in controlling microsite navigation, the checkbox labeled “Hide Automatic Display of Group 

Nodes” places these links in a grey box that is visible only to group administrators. (See Figure 2.) If 

you decide to use this option, customized menus should be created to direct users to your content. 

General Functions 

The following functions are common to many group content types: 

Add Node 
Click the “add” links in the right-hand administrator menu to create nodes according to content type. 

Display of these links is contingent upon your designated permissions. 

Edit Node 
Authenticated users with the requisite permissions will see “View” and “Edit” tabs at the top of 

nodes they are authorized to edit. Click the Edit tab to access the editing tools. 

Revisions 
Every time you edit and save a node, a copy of the old version is automatically recorded. You may 

also enter a log message for internal reference purposes. Prior versions, if applicable, may be 

accessed via the “Revisions” tab. Please note, however, that prior versions of the Group Homepage 

are not maintained. 
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Figure 2. Group Homepage with automatic display of group nodes (“auto-links”) hidden. 

 

 
Figure 3. “Insert/edit image” icon and dialog box. 
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Rich-text Formatting 
Most content types feature at least one long-text field with a WYSIWYG1 formatting toolbar (see 

Figure 3). This toolbar may be used for relatively simple formatting such as boldface, italic, bullet 

lists, numbered lists, indentation, and editing of static hyperlinks.  

Tips for Using the Formatting Toolbar Effectively:  

 When pasting text from Word, be sure to use the “Paste from Word” icon to strip 

out incompatible code. 

 Use the eraser icon to Remove Formatting applied in external applications. Note: 

This may require reapplication of your desired formatting. 

 Use the Format drop-down menu to apply standardized styles (e.g., H2, H3, etc.) for 

headers and sub-headers. 

Input Format:  Two editing modes may be used: 

1. Filtered HTML (recommended) is the default mode that displays the toolbar. 

2. Full HTML enables you to edit your markup code directly.  Tip: Nodes edited in Full 

HTML mode must be saved in that mode for some tags to render. (Changing modes 

will “filter” them out.) 

Inserting and Editing Images 
The formatting toolbar features an icon that allows you to easily insert and edit inline images. The 

icon looks like a tree (see Figure 3). Images are inserted at your cursor’s location. Clicking on the icon 

opens a dialog box in which you can set the image URL, description, alignment, dimensions, border, 

and vertical/horizontal space to appear around the image (i.e., the gutter). 

To the right of the Image URL field is a “Browse” icon. Clicking this icon opens another dialog box that 

displays your individual user folder in Drupal. You may use the “Upload” link to upload image files 

from your local drive. Uploaded files may be highlighted and inserted into your node by clicking on 

the “Insert” link. Upon returning to the “Insert/edit image” dialog box, you will notice that the Image 

URL field is now populated with the absolute path to your image in Drupal. Click again on the “Insert” 

button to return to your node edit screen. You will now see your image in the WYSIWYG text field. 

Promote to Group Front Page and SAA News Feed 
Links to News Items, Newsletters, Reports, and Meetings nodes are automatically displayed in 

reverse chronological order on your group homepage and on the Global SAA Newsfeed at 

http://www2.archivists.org/newsfeed if and when the checkbox on the node edit screen is checked 

(default). Items can also be designated as “sticky” under Publishing Options, found at the bottom of 

the node edit screen. Sticky nodes will remain at the top of your homepage feed above other more 

recently created content. 

                                                           
1
 “What you see is what you get” (WYSIWYG) 

http://www2.archivists.org/newsfeed
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Figure 4. The “Public” checkbox on the node edit screen. 

 

Administering Public vs. Private Content 
Under the “Groups” header on the node edit screen is a checkbox labeled “Public” (see Figure 4). 

Check this box to make the node appear to users outside of your group leadership.  

There are two methods to administer private content—i.e., nodes viewable only by your group 

leaders and staff: 

“Weak” Method:  If you leave the checkbox labeled “Public” unchecked, links to the node 

will not display in your News Feed or in the auto-links block for public users. Such links will 

appear for your group leaders and for staff. There are two limitations to this method: 

 Static links embedded in other group nodes or on external sites are unaffected by 

the “Public” checkbox setting. 

 Actual access to the node is not restricted. If a public user browses to your private 

node via a static link or by typing the URL directly into her browser, the content will 

display. Therefore, confidential information should not be managed via this method. 

“Strong” Method:  All group content types have been configured with per-node access 

control. Group Officers have permission to use these settings, which are managed via the 

“Access control” tab displayed to the right of the “Revisions” tab (see Figure 5). 

This screen allows Group Officers to override the standard node permissions specified in the 

table on Page 4 of this manual. These controls supersede the Public checkbox setting and 

should be used as follows. (Note: Numbers below correspond to labels in Figure 5.) 

1. Under “View any content,” uncheck anonymous user and authenticated user. This 

removes the default view permission granted to all public users. 

2. Under “View any content,” check group contributor, group editor, and group officer. 

This re-grants view permission to your group leaders. (Note: You may ignore group 

manager. That role is not used.) 

3. If you wish to grant view permission only to SAA members, check the saa member 

role under “View any content.” 

4. Uncheck anonymous user and authenticated user under “View own content.” 

5. DO NOT ALTER any settings labeled “Edit * content” or “Delete * content.” Changing 

these controls risks unauthorized modification to and/or deletion of your content! 
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Figure 5. The Access Control screen. (See page 9 for instructions regarding numbered blocks above.) 

 

File Attachments 
Use this feature to upload and display file attachments with the node. 

Comment Settings 
Specify whether authenticated users may read and/or add Comments to the node. 
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Content Type Descriptions 

Group Menus 
Group Officers can create and edit any number of Group Menus, each of which has its own name and 

any number of sortable links. Group Menus themselves may also be sorted via the Node Weight 

control on the menu’s Edit tab. Smaller values are considered lighter and will appear above heavier 

items. Group menus display in the right-hand margin of your microsite and may be edited by clicking 

on the respective links under “Group Menu” in the auto-links block. 

SAA staff will work with group leaders to configure a core menu with links to information about the 

group maintained in the AMS and elsewhere (e.g., leader rosters, group member directory, email 

discussion list(s), etc.) We strongly discourage groups from duplicating such information on static 

nodes in the microsites. Please contact Brian Doyle at bdoyle@archivists.org for assistance. 

Group News Items 
Group News Items are designed to support miscellaneous announcements and updates that you 

want to share with the public. These may include calls for newsletter submissions, calls for 

nominations, etc. Group News Items may be added to your homepage feed. News items consist of a 

Title, a Short Description that displays on the group homepage feed (if applicable), a rich-text 

Content field, Links, and File attachments. 

Group Pages 
Group Pages are a generic content type for permanent or semi-permanent nodes such as Section and 

Roundtable bylaws, editorial guidelines for newsletter submissions, etc. Group Pages consist of a 

Title, a rich-text Body field, and File attachments.  

Group Pages may not be added to your homepage feed. Group Pages should not be used to 

duplicate information that is maintained by staff in the AMS or elsewhere in Drupal—e.g., leader 

rosters, member rosters, SAA Governance Manual content, etc. Rather, staff will work with group 

leaders to configure custom Group Menus to link to this content as needed. 

Group Newsletters 
Group Newsletters consist of a Title, a Short Description that displays on the group homepage feed  

(if applicable), a rich-text Body field, and File attachments. Group Newsletters may be added to your 

homepage feed.  

Group Reports 
Group Reports consist of a Title, a Short Description that displays on the group homepage feed  

(if applicable), a rich-text Body field, and File attachments. Group Reports may be added to your 

homepage feed.  

mailto:bdoyle@archivists.org
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Group Meetings 
Group Meetings consist of a Meeting Name, Location fields (e.g.,  Location Name, Contact Name, 

Address, etc.), Meeting Date(s), a Short Description that displays on the group homepage feed  (if 

applicable), a rich-text Description, a Referenced Meeting Agenda pointer, a Referenced Group 

Minutes pointer, and File attachments. Group Meetings may be added to your homepage feed. 

Group Meetings provide a mechanism to manage and display structured relationships with content 

that is related to the meeting. For example, Meeting Agendas may be published as formatted text in 

the Description field, as a File attachment, or as a hierarchical set of child nodes. Use of the child 

Content Types is more complex but allows for granular content settings (e.g., Comments, etc.) 

Meeting Agendas 

Meeting Agendas consist of an Agenda Name, a rich-text Introduction field, a Referenced Group 

Meeting (parent node) pointer, and Referenced Agenda Item (child node) pointers. The meeting 

agenda content type is configured to dynamically display hyperlinks to constituent agenda items. 

Agenda Items 

Agenda Items consist of an Item Name, a plain-text Presenter field, a rich-text Abstract 

field, a Referenced Meeting Agenda (parent node) pointer, a Node Weight field that 

controls sorting of the agenda items within the Agenda, and File attachments. There is 

also a rich-text Prefatory Text field that you may use to specify sub-headers (e.g., Old 

Business, New Business, etc.) that you want to display on the Meeting Agenda. 

Meeting Minutes 

Meeting Minutes consist of a Title, a rich-text Body field, a Referenced Group Meeting (parent 

node) pointer, and File attachments. Links to referenced meeting minutes are dynamically 

displayed on the Group Meeting node. 

Standards 

Standards are a special content type that works in conjunction with the SAA Standards Portal 

(http://www2.archivists.org/standards). According to the Standards Committee guidelines, these 

documents include standards, technical standards, conventions, rules, guidelines, and best practices. 

SAA Standards that are formally adopted by the Council and assigned to a component group for 

ongoing maintenance are among those included in the portal. Draft SAA standards may also be 

included, pending approval from the Standards Committee. 

Once a Standard is added to the portal and assigned a maintaining group, it will be listed among the 

group’s nodes in the auto-links block. Custom links may also be displayed via a Group Menu. Group 

Officers have permissions to edit a Standard. That being said, revisions to SAA-adopted standards 

must be approved by the SAA Council. Please do not edit such documents without consulting with 

the SAA staff in advance. For more information about maintaining Standards, contact Brian Doyle at 

bdoyle@archivists.org. 

http://www2.archivists.org/standards
mailto:bdoyle@archivists.org

